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Elemente eines RMarkdown Dokuments

Welche Elemente hat eine R Markdown Datei?

Metadaten in RMarkdown

Überblick übr YAML

✚ .Rmd Dokumente beginnen mit einem YAML-Header

✚ Definition der Metadaten wie Titel, Datum, Output-Format ...

✚ Wir zwischen drei --- geschrieben

---

title:

output:

---

Überblick übr YAML

✚ .Rmd Dokumente beginnen mit einem YAML-Header

✚ Definition der Metadaten wie Titel, Datum, Output-Format ...

✚ Wir zwischen drei --- geschrieben

---

title:

output:

---

✚ Variablennamen (title, output etc) werden immer klein geschrieben und darauf folgt ein Doppelpunkt : mit
anschließendem Leerzeichen

✚ Alle verfügbaren Variablen und deren Optionen finden Sie in Pandoc's User Guide

✚ Außerdem ist das R Markdown Cheat Sheet sehr hilfreich

YAML Variablen

YAML Variablen können Text

---

title: "Das ist ein Text"

output:

---

YAML Variablen

YAML Variablen können Text, Optionen

---

title: "Das ist ein Text"

output: html_document

---

YAML Variablen

YAML Variablen können Text, Optionen, Unteroptionen

---

title: "Das ist ein Text"

output: 

  html_document:

     keep_md: TRUE

---

YAML Variablen

YAML Variablen können Text, Optionen, Unteroptionen und Code enthalten

---

title: "Das ist ein Text"

date: "r format(Sys.Date(), '%d %B %Y')"

output: 

  html_document:

    keep_md: TRUE

---

YAML Variablen

YAML Variablen können Text, Optionen, Unteroptionen und Code enthalten

---

title: "Das ist ein Text"

date: "r format(Sys.Date(), '%d %B %Y')"

output: 

  html_document:

    keep_md: TRUE

---

Im Projektkurs erstellen wir HTMLs und Markdown Dokumente durch folgenden YAML-Header:

---

title: "Das ist ein Text"

output: 

   html_document:

     keep_md: TRUE

---

YAML Variablen

YAML Variablen können Text, Optionen, Unteroptionen und Code enthalten

---

title: "Das ist ein Text"

date: "r format(Sys.Date(), '%d %B %Y')"

output: 

  html_document:

    keep_md: TRUE

---

Im Projektkurs erstellen wir HTMLs und Markdown Dokumente durch folgenden YAML-Header:

---

title: "Das ist ein Text"

output: 

   html_document:

     keep_md: TRUE

---

✚ Sie müssen auf das Einrücken der dritten Zeile (keep_md) achten!

HTML aufwerten

Kleine Änderungen im YAML Header haben große Auswirkungen!

HTML aufwerten

Kleine Änderungen im YAML Header haben große Auswirkungen!

HTML aufwerten

Kleine Änderungen im YAML Header haben große Auswirkungen!
Nur mit output: html_document theme, toc und toc_float definiert

HTML aufwertenHTML aufwertenHTML aufwertenHTML aufwertenHTML aufwerten

Im Projektkurs nutzen wir das theme = "cosmo" und setzen ein Inhaltsverzeichnis (toc = TRUE) ein.
Dieses
Inhaltsverzeichnis soll an der linken Seite der HTML erscheinen (toc_float = TRUE).

---

title: "Das ist ein Text"

output: 

   html_document:

     keep_md: TRUE

     toc: TRUE

     toc_float: TRUE

     theme: "cosmo"

---

HTML aufwerten

Im Projektkurs nutzen wir das theme = "cosmo" und setzen ein Inhaltsverzeichnis (toc = TRUE) ein.
Dieses
Inhaltsverzeichnis soll an der linken Seite der HTML erscheinen (toc_float = TRUE).

---

title: "Das ist ein Text"

output: 

   html_document:

     keep_md: TRUE

     toc: TRUE

     toc_float: TRUE

     theme: "cosmo"

---

Es gibt auch noch andere Themes. Diese finden Sie hier (aber bitte nicht im Projektkurs verwenden!)

Von R Markdown zum gewünschten Output-
Format

Durch das komplieren ( knitten ) ihres Dokuments bekommen Sie das von ihnen angegebene Dokument

.Rmd --knitr --> .md --pandoc --> output

✚ Knitr konvertiert ihr Dokument von .Rmd (RMarkdown) in eine .md (Markdown) Datei

✚ pandoc transformiert die .md Datei anschließend in ihr gewünschtes Format

✚ Bspw. HTML, Word, PDF, LateX ...

✚ In R-Studio drücken Sie für diesen Prozess einfach den knitr-Button

Vielseitigkeit von RMarkdown

✚ HTMLs

✚ Github Markdown Dokumente

✚ PDFs

✚ Präsentationen

✚ Dashboards

✚ Bücher (Stichwort bookdown)

✚ Webseiten (Stichwort blogdown)

✚ und noch vieles weitere ...

Eine ausführliche Erklärung im open access Buch: RMarkdown the definitive Guide

Oder auch im R Markdown Reference Guide

TeX Installation um PDFs erzeugen zu können

Falls Sie eine TeX-Live oder andere TeX/LateX Version auf ihrem Rechner installiert haben ✔️

TeX Installation um PDFs erzeugen zu können

Falls Sie eine TeX-Live oder andere TeX/LateX Version auf ihrem Rechner installiert haben ✔️

Falls nicht, dann können Sie sich eine Minimale TeX-Version (tinytex von Xie(2020)) über R installieren:

install.packages(c("tinytex"))

tinytex::install_tinytex()

Es können unterschiedlichste Output Formate erzeugt
werden.

Unter anderen:

✚ HTML

---

title: "Das ist ein Text"

output: html_document

---

YAML - Output Formate

Es können unterschiedlichste Output Formate erzeugt
werden.

Unter anderen:

✚ HTML

✚ Latex

---

title: "Das ist ein Text"

output: latex_document

---

YAML - Output Formate

Es können unterschiedlichste Output Formate erzeugt
werden.

Unter anderen:

✚ HTML

✚ Latex

✚ PDF

---

title: "Das ist ein Text"

output: pdf_document

---

YAML - Output Formate

Es können unterschiedlichste Output Formate erzeugt
werden.

Unter anderen:

✚ HTML

✚ Latex

✚ PDF

✚ Word

---

title: "Das ist ein Text"

output: word_document

---

YAML - Output FormateYAML - Output Formate

✚ Wir erzeugen im Projektkurs eine HTML und .md-Dateien um das Projekt auch immer in Github schnell anschauen zu
können

Probieren Sie es aus! Klicken Sie auf die .md-Datei ihres 1. Projekts auf Github!

Code Chunk Optionen

Code Chunk Optionen

In einem Chunk haben Sie mehrere Optionen, wie dieser von R interpretiert werden soll.

Allgemeiner Chunk:

✚ echo: "TRUE"/"FALSE" (Code aus Chunk zeigen/nicht zeigen)

✚ message: "TRUE"/"FALSE" (Benachrichtigungen anzeigen/nicht anzeigen)

✚ warnings: "TRUE"/"FALSE" (Warnmeldungen anzeigen/nicht anzeigen)

✚ eval: "TRUE"/"FALSE" (Chunk nicht beachten/beachten)

✚ include: "TRUE"/"FALSE" (Code Output zeigen/nicht zeigen)

✚ results: "asis"/"hide" (Output wie er vom Chunk kommt anzeigen/nicht zeigen)

Code Chunk Optionen

In einem Chunk haben Sie mehrere Optionen, wie dieser von R interpretiert werden soll.

Allgemeiner Chunk:

✚ echo: "TRUE"/"FALSE" (Code aus Chunk zeigen/nicht zeigen)

✚ message: "TRUE"/"FALSE" (Benachrichtigungen anzeigen/nicht anzeigen)

✚ warnings: "TRUE"/"FALSE" (Warnmeldungen anzeigen/nicht anzeigen)

✚ eval: "TRUE"/"FALSE" (Chunk nicht beachten/beachten)

✚ include: "TRUE"/"FALSE" (Code Output zeigen/nicht zeigen)

✚ results: "asis"/"hide" (Output wie er vom Chunk kommt anzeigen/nicht zeigen)

Zusätzlich bei Schaubildern:

✚ out.width: Nummer (Breite des Outputs, kann auch in '%' angegeben werden)

✚ fig.height: Nummer (Höhe eines Schaubilds festlegen)

✚ fig.width: Nummer (Breite eines Schaubilds festlegen)

✚ dpi: Nummer (Qualität ihrer Grafik, für eine höhere Qualität dpi=300 angeben)

```{r, echo=FALSE}

library(tidyverse)

summary(economics)

```

echo

Wir nutzen den in tidyverse enthaltenen Datensatz economics als Basis für die folgenden Schaubilder.

```{r, echo=FALSE}

library(tidyverse)

summary(economics)

```

## ── Attaching core tidyverse packages ───────────

## ✔ dplyr     1.1.4     ✔ readr     2.1.5
## ✔ forcats   1.0.0     ✔ stringr   1.5.1
## ✔ ggplot2   3.5.1     ✔ tibble    3.2.1
## ✔ lubridate 1.9.3     ✔ tidyr     1.3.1
## ✔ purrr     1.0.2     
## ── Conflicts ───────────────────────────────────

## ✖ dplyr::filter() masks stats::filter()
## ✖ dplyr::lag()    masks stats::lag()
## ℹ Use the conflicted package (<http://conflicted

##       date                 pce               pop

##  Min.   :1967-07-01   Min.   :  506.7   Min.   :

##  1st Qu.:1979-06-08   1st Qu.: 1578.3   1st Qu.:

##  Median :1991-05-16   Median : 3936.8   Median :

##  Mean   :1991-05-17   Mean   : 4820.1   Mean   :

##  3rd Qu.:2003-04-23   3rd Qu.: 7626.3   3rd Qu.:

##  Max.   :2015-04-01   Max.   :12193.8   Max.   :

echo

Wir nutzen den in tidyverse enthaltenen Datensatz economics als Basis für die folgenden Schaubilder.
```{r, message = FALSE, warning = FALSE}

library(tidyverse)

```

message/warning

```{r, message = FALSE, warning = FALSE}

library(tidyverse)

```

library(tidyverse)

message/warning

```{r, eval=FALSE}

library(tidyverse)

summary(economics)

```

eval

```{r, eval=FALSE}

library(tidyverse)

summary(economics)

```

library(tidyverse)

summary(economics)

eval

```{r, out.width = '70%', echo=FALSE}

library(tidyverse)

qplot(economics$pop)

```

out.width

```{r, out.width = '70%', echo=FALSE}

library(tidyverse)

qplot(economics$pop)

```

```{r, out.width = '10%', echo=FALSE}

library(tidyverse)

qplot(economics$pop)

```

Andere Optionen bspw.:

✚ fig.width

✚ fig.high

out.width

One Chunk to rule them all. (Alison Hill)

```{r setup, include = FALSE}

knitr::opts_chunk$set(

  warning = FALSE,

  message = FALSE,

  echo = FALSE,

  fig.path = "figs/"

)

```

✚ Chunk bekommt das Label setup

✚ Ist der erste Chunk in einem RMarkdown Dokument

✚ Hier werden globale Optionen für alle folgenden
Chunks definiert

✚ Sie können weiterhin in jedem Chunk individuelle
Optionen verwenden und diese globalen Optionen
überschreiben

✚ Tipp: Verwenden Sie für den setup Chunk include =
FALSE damit er nicht im Dokuemnt auftaucht

Global setup chunks

Präsentationen mit R Markdown

Präsentationen mit R Markdown mit dem Paket
xaringan

Wir wollen uns noch speziell mit Präsentationen mit R Markdown beschäftigen!

Präsentationen mit R Markdown mit dem Paket
xaringan

Wir wollen uns noch speziell mit Präsentationen mit R Markdown beschäftigen!

✚ Ihre Projektausarbeitung ist bereits in R Markdown

✚ Durch kleine Änderungen im YAML-Header können Sie daraus eine Präsentation erstellen mit Grafiken direkt aus R
mit hoher Qualität

✚ Pro Tip: Im Code Chunk dpi = 300 verwenden für gestochen scharfe Grafiken

#install.packages(xaringan)

library(xaringan)

Output-Format

---

output: xaringan::moon_reader

---

✚ Die erste Folie beginnt dort wo der YAML-Header
endet!

✚ Durch drei --- können Sie eine neue Folie beginnen

---

output: xaringan::moon_reader

---

Ich bin ihre 1. Folie

---

Und ich ihre zweite

Neue Folien

✚ Die erste Folie beginnt dort wo der YAML-Header
endet!

✚ Durch drei --- können Sie eine neue Folie beginnen

---

output: xaringan::moon_reader

---

Ich bin ihre 1. Folie

---

Und ich ihre zweite

Neue Folien

Sie können jede Folie individuell designen mit der
class: Option.

Möglichkeiten:

✚ Für die Position des Geschriebenen (vertikal): top,
bottom, middle

✚ Für die Position des Geschriebenen (horizontal): left,
right, center

✚ Um das Farbschema umzudrehen: inverse

---

output: xaringan::moon_reader

---

class: inverse, center, middle

# Introfolie

---

class: bottom, right

# Vorstellung

Ich bin ihre 1. Folie

---

Und ich ihre zweite

Neue Folien designenDas Paket xaringanthemer
#install.packages("xaringanthemer")

library(xaringanthemer)

✚ Damit können Sie ihre Präsentationen auch ohne CSS oder remark.js Kenntnisse leicht anpassen und individualisieren

✚ Eine Einführung in xaringanthemer finden Sie hier

✚ Eine Einführung in xaringan finden Sie hier

Ein beispielhafter YAML-Header
---

author: Alexander Rieber

date: '2024-10-04'

title: Beispielpräsentation in xaringan

output: 

  xaringan::moon_reader

    css: xaringan-themer.css

---

```{r xaringan-themer, include=FALSE, warning=FALSE}

library(xaringanthemer)

style_mono_accent(

  #Farbpalette richtet sich nach Hex-Farbcode (bspw. hier: https://encycolorpedia.de/)

  #Farbpalette kann leicht angepasst werden

  base_color = "#1c5253", 

  header_font_google = google_font("Josefin Sans"),

  text_font_google   = google_font("Montserrat", "300", "300i"),

  code_font_google   = google_font("Fira Mono")

)

```

Präsentationen
✚ Sie können sich auch gerne an den Folien zum Projektkurs orientieren z.B. mit dem Format 16:9 (ratio: "16:9")

✚ Natürlich müssen Sie ihre Ausarbeitung nicht in xaringan machen!

Jedoch bietet es sich an um die schönen Grafiken und Tabellen ohne Verlust in die Präsentation aufnehmen zu können.

R Projekte

Arbeiten mit R-Projekten

In R sollten Sie ihre Arbeit in Projekte strukturieren.

Ist sehr nützlich da in dem Fall alle nötigen Dateien beieinander in einem Projekt liegen, inkl. Historie etc.

✚ Mehr Informationen zu R-Projekten und warum diese sinnvoll sind finden Sie hier

Sie sollten für ihre unterschiedlichen Projekte immer einzelne R-Projekte erstellen

Arbeiten mit R-Projekten

In R sollten Sie ihre Arbeit in Projekte strukturieren.

Ist sehr nützlich da in dem Fall alle nötigen Dateien beieinander in einem Projekt liegen, inkl. Historie etc.

✚ Mehr Informationen zu R-Projekten und warum diese sinnvoll sind finden Sie hier

Sie sollten für ihre unterschiedlichen Projekte immer einzelne R-Projekte erstellen

Projekt erzeugen bei vorhandenem Ordner:

File -> New Project -> Existing Directory -> Browse -> Open .Rmd

Projekt erzeugen bei neuem Ordner:

File -> New Project -> New Directory -> New Projekt -> Neuer Ordner erstellen

Take aways
✚ Nutzen Sie YAML um Metadaten für ihr Dokument zu setzen

✚ Nutzen Sie YAML auch um ihr Dokument entsprechend aufzubauen (Inhaltsübersicht, Themes etc.)

✚ Verwenden Sie knitr Chunk Optionen (eval, echo, include ...) um ihr finales Dokument entsprechend zu gestalten

✚ Verwenden Sie fett, kursiv und Listenelemente um ihren Text zu strukturieren

✚ Verwenden Sie R Projekte für jedes neue Projekt das Sie starten

Take aways
✚ Nutzen Sie YAML um Metadaten für ihr Dokument zu setzen

✚ Nutzen Sie YAML auch um ihr Dokument entsprechend aufzubauen (Inhaltsübersicht, Themes etc.)

✚ Verwenden Sie knitr Chunk Optionen (eval, echo, include ...) um ihr finales Dokument entsprechend zu gestalten

✚ Verwenden Sie fett, kursiv und Listenelemente um ihren Text zu strukturieren

✚ Verwenden Sie R Projekte für jedes neue Projekt das Sie starten

knitten Sie früh und oft! Nur so können Sie sicher gehen das ihre Ergebnisse zu 100% reproduzierbar sind!

Quellen

✚ Eine sehr gute Einführung in RMarkdown und wie man damit wissenschaftliche Texte (z.B. auch Bachelorarbeiten)
schreibt finden Sie hier

✚ Eine allgemeine Einführung in RMarkdown von Alison Horst

✚ Alle Zeichnungen von Allison Horst und Desirée de Leon

Advanced R Markdown

https://pandoc.org/MANUAL.html
https://raw.githubusercontent.com/rstudio/cheatsheets/main/rmarkdown-2.0.pdf
https://rmarkdown.rstudio.com/gallery.html
https://bookdown.org/yihui/rmarkdown/
https://rmarkdown.rstudio.com/docs/reference/index.html#section-output-formats
https://pkg.garrickadenbuie.com/xaringanthemer/
https://slides.yihui.org/xaringan/#1
https://support.posit.co/hc/en-us/articles/200526207-Using-RStudio-Projects
https://support.posit.co/hc/en-us/articles/200526207-Using-RStudio-Projects
https://resulumit.com/teaching/rmd_workshop.html
https://alison.rbind.io/tags/rmarkdown/
https://www.allisonhorst.com/
https://desiree.rbind.io/
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✚ YAML-Header

✚ Text
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✚ YAML-Header

✚ Text

✚ Code-Chunks

Elemente eines RMarkdown Dokuments

Welche Elemente hat eine R Markdown Datei?



Metadaten in RMarkdown



Überblick übr YAML

✚ .Rmd Dokumente beginnen mit einem YAML-Header

✚ Definition der Metadaten wie Titel, Datum, Output-Format ...

✚ Wir zwischen drei --- geschrieben

---

title:

output:

---



Überblick übr YAML

✚ .Rmd Dokumente beginnen mit einem YAML-Header

✚ Definition der Metadaten wie Titel, Datum, Output-Format ...

✚ Wir zwischen drei --- geschrieben

---

title:

output:

---

✚ Variablennamen (title, output etc) werden immer klein geschrieben und darauf folgt ein Doppelpunkt : mit
anschließendem Leerzeichen

✚ Alle verfügbaren Variablen und deren Optionen finden Sie in Pandoc's User Guide

✚ Außerdem ist das R Markdown Cheat Sheet sehr hilfreich

https://pandoc.org/MANUAL.html
https://raw.githubusercontent.com/rstudio/cheatsheets/main/rmarkdown-2.0.pdf


YAML Variablen

YAML Variablen können Text

---

title: "Das ist ein Text"

output:

---



YAML Variablen

YAML Variablen können Text, Optionen

---

title: "Das ist ein Text"

output: html_document

---



YAML Variablen

YAML Variablen können Text, Optionen, Unteroptionen

---

title: "Das ist ein Text"

output: 

  html_document:

     keep_md: TRUE

---



YAML Variablen

YAML Variablen können Text, Optionen, Unteroptionen und Code enthalten

---

title: "Das ist ein Text"

date: "r format(Sys.Date(), '%d %B %Y')"

output: 

  html_document:

    keep_md: TRUE

---



YAML Variablen

YAML Variablen können Text, Optionen, Unteroptionen und Code enthalten

---

title: "Das ist ein Text"

date: "r format(Sys.Date(), '%d %B %Y')"

output: 

  html_document:

    keep_md: TRUE

---

Im Projektkurs erstellen wir HTMLs und Markdown Dokumente durch folgenden YAML-Header:

---

title: "Das ist ein Text"

output: 

   html_document:

     keep_md: TRUE

---



YAML Variablen

YAML Variablen können Text, Optionen, Unteroptionen und Code enthalten

---

title: "Das ist ein Text"

date: "r format(Sys.Date(), '%d %B %Y')"

output: 

  html_document:

    keep_md: TRUE

---

Im Projektkurs erstellen wir HTMLs und Markdown Dokumente durch folgenden YAML-Header:

---

title: "Das ist ein Text"

output: 

   html_document:

     keep_md: TRUE

---

✚ Sie müssen auf das Einrücken der dritten Zeile (keep_md) achten!



HTML aufwerten

Kleine Änderungen im YAML Header haben große Auswirkungen!



HTML aufwerten

Kleine Änderungen im YAML Header haben große Auswirkungen!



HTML aufwerten

Kleine Änderungen im YAML Header haben große Auswirkungen!



Nur mit output: html_document theme, toc und toc_float definiert

HTML aufwerten



HTML aufwerten



HTML aufwerten



HTML aufwerten



HTML aufwerten

Im Projektkurs nutzen wir das theme = "cosmo" und setzen ein Inhaltsverzeichnis (toc = TRUE) ein.
Dieses
Inhaltsverzeichnis soll an der linken Seite der HTML erscheinen (toc_float = TRUE).

---

title: "Das ist ein Text"

output: 

   html_document:

     keep_md: TRUE

     toc: TRUE

     toc_float: TRUE

     theme: "cosmo"

---



HTML aufwerten

Im Projektkurs nutzen wir das theme = "cosmo" und setzen ein Inhaltsverzeichnis (toc = TRUE) ein.
Dieses
Inhaltsverzeichnis soll an der linken Seite der HTML erscheinen (toc_float = TRUE).

---

title: "Das ist ein Text"

output: 

   html_document:

     keep_md: TRUE

     toc: TRUE

     toc_float: TRUE

     theme: "cosmo"

---

Es gibt auch noch andere Themes. Diese finden Sie hier (aber bitte nicht im Projektkurs verwenden!)

https://rmarkdown.rstudio.com/gallery.html


Von R Markdown zum gewünschten Output-

Format

Durch das komplieren ( knitten ) ihres Dokuments bekommen Sie das von ihnen angegebene Dokument

.Rmd --knitr --> .md --pandoc --> output

✚ Knitr konvertiert ihr Dokument von .Rmd (RMarkdown) in eine .md (Markdown) Datei

✚ pandoc transformiert die .md Datei anschließend in ihr gewünschtes Format

✚ Bspw. HTML, Word, PDF, LateX ...

✚ In R-Studio drücken Sie für diesen Prozess einfach den knitr-Button





Vielseitigkeit von RMarkdown

✚ HTMLs

✚ Github Markdown Dokumente

✚ PDFs

✚ Präsentationen

✚ Dashboards

✚ Bücher (Stichwort bookdown)

✚ Webseiten (Stichwort blogdown)

✚ und noch vieles weitere ...

Eine ausführliche Erklärung im open access Buch: RMarkdown the definitive Guide

Oder auch im R Markdown Reference Guide

https://bookdown.org/yihui/rmarkdown/
https://rmarkdown.rstudio.com/docs/reference/index.html#section-output-formats


TeX Installation um PDFs erzeugen zu können

Falls Sie eine TeX-Live oder andere TeX/LateX Version auf ihrem Rechner installiert haben ✔️



TeX Installation um PDFs erzeugen zu können

Falls Sie eine TeX-Live oder andere TeX/LateX Version auf ihrem Rechner installiert haben ✔️

Falls nicht, dann können Sie sich eine Minimale TeX-Version (tinytex von Xie(2020)) über R installieren:

install.packages(c("tinytex"))

tinytex::install_tinytex()



Es können unterschiedlichste Output Formate erzeugt
werden.

Unter anderen:

✚ HTML

---

title: "Das ist ein Text"

output: html_document

---

YAML - Output Formate



Es können unterschiedlichste Output Formate erzeugt
werden.

Unter anderen:

✚ HTML

✚ Latex

---

title: "Das ist ein Text"

output: latex_document

---

YAML - Output Formate



Es können unterschiedlichste Output Formate erzeugt
werden.

Unter anderen:

✚ HTML

✚ Latex

✚ PDF

---

title: "Das ist ein Text"

output: pdf_document

---

YAML - Output Formate



Es können unterschiedlichste Output Formate erzeugt
werden.

Unter anderen:

✚ HTML

✚ Latex

✚ PDF

✚ Word

---

title: "Das ist ein Text"

output: word_document

---

YAML - Output Formate



YAML - Output Formate

✚ Wir erzeugen im Projektkurs eine HTML und .md-Dateien um das Projekt auch immer in Github schnell anschauen zu
können

Probieren Sie es aus! Klicken Sie auf die .md-Datei ihres 1. Projekts auf Github!





Code Chunk Optionen



Code Chunk Optionen

In einem Chunk haben Sie mehrere Optionen, wie dieser von R interpretiert werden soll.

Allgemeiner Chunk:

✚ echo: "TRUE"/"FALSE" (Code aus Chunk zeigen/nicht zeigen)

✚ message: "TRUE"/"FALSE" (Benachrichtigungen anzeigen/nicht anzeigen)

✚ warnings: "TRUE"/"FALSE" (Warnmeldungen anzeigen/nicht anzeigen)

✚ eval: "TRUE"/"FALSE" (Chunk nicht beachten/beachten)

✚ include: "TRUE"/"FALSE" (Code Output zeigen/nicht zeigen)

✚ results: "asis"/"hide" (Output wie er vom Chunk kommt anzeigen/nicht zeigen)



Code Chunk Optionen

In einem Chunk haben Sie mehrere Optionen, wie dieser von R interpretiert werden soll.

Allgemeiner Chunk:

✚ echo: "TRUE"/"FALSE" (Code aus Chunk zeigen/nicht zeigen)

✚ message: "TRUE"/"FALSE" (Benachrichtigungen anzeigen/nicht anzeigen)

✚ warnings: "TRUE"/"FALSE" (Warnmeldungen anzeigen/nicht anzeigen)

✚ eval: "TRUE"/"FALSE" (Chunk nicht beachten/beachten)

✚ include: "TRUE"/"FALSE" (Code Output zeigen/nicht zeigen)

✚ results: "asis"/"hide" (Output wie er vom Chunk kommt anzeigen/nicht zeigen)

Zusätzlich bei Schaubildern:

✚ out.width: Nummer (Breite des Outputs, kann auch in '%' angegeben werden)

✚ fig.height: Nummer (Höhe eines Schaubilds festlegen)

✚ fig.width: Nummer (Breite eines Schaubilds festlegen)

✚ dpi: Nummer (Qualität ihrer Grafik, für eine höhere Qualität dpi=300 angeben)



```{r, echo=FALSE}

library(tidyverse)

summary(economics)

```

echo

Wir nutzen den in tidyverse enthaltenen Datensatz economics als Basis für die folgenden Schaubilder.



```{r, echo=FALSE}

library(tidyverse)

summary(economics)

```

## ── Attaching core tidyverse packages ───────────

## ✔ dplyr     1.1.4     ✔ readr     2.1.5
## ✔ forcats   1.0.0     ✔ stringr   1.5.1
## ✔ ggplot2   3.5.1     ✔ tibble    3.2.1
## ✔ lubridate 1.9.3     ✔ tidyr     1.3.1
## ✔ purrr     1.0.2     
## ── Conflicts ───────────────────────────────────

## ✖ dplyr::filter() masks stats::filter()
## ✖ dplyr::lag()    masks stats::lag()
## ℹ Use the conflicted package (<http://conflicted

##       date                 pce               pop

##  Min.   :1967-07-01   Min.   :  506.7   Min.   :

##  1st Qu.:1979-06-08   1st Qu.: 1578.3   1st Qu.:

##  Median :1991-05-16   Median : 3936.8   Median :

##  Mean   :1991-05-17   Mean   : 4820.1   Mean   :

##  3rd Qu.:2003-04-23   3rd Qu.: 7626.3   3rd Qu.:

##  Max.   :2015-04-01   Max.   :12193.8   Max.   :

echo

Wir nutzen den in tidyverse enthaltenen Datensatz economics als Basis für die folgenden Schaubilder.



```{r, message = FALSE, warning = FALSE}

library(tidyverse)

```

message/warning



```{r, message = FALSE, warning = FALSE}

library(tidyverse)

```

library(tidyverse)

message/warning



```{r, eval=FALSE}

library(tidyverse)

summary(economics)

```

eval



```{r, eval=FALSE}

library(tidyverse)

summary(economics)

```

library(tidyverse)

summary(economics)

eval



```{r, out.width = '70%', echo=FALSE}

library(tidyverse)

qplot(economics$pop)

```

out.width



```{r, out.width = '70%', echo=FALSE}

library(tidyverse)

qplot(economics$pop)

```

```{r, out.width = '10%', echo=FALSE}

library(tidyverse)

qplot(economics$pop)

```

Andere Optionen bspw.:

✚ fig.width

✚ fig.high

out.width



One Chunk to rule them all. (Alison Hill)

```{r setup, include = FALSE}

knitr::opts_chunk$set(

  warning = FALSE,

  message = FALSE,

  echo = FALSE,

  fig.path = "figs/"

)

```

✚ Chunk bekommt das Label setup

✚ Ist der erste Chunk in einem RMarkdown Dokument

✚ Hier werden globale Optionen für alle folgenden
Chunks definiert

✚ Sie können weiterhin in jedem Chunk individuelle
Optionen verwenden und diese globalen Optionen
überschreiben

✚ Tipp: Verwenden Sie für den setup Chunk include =
FALSE damit er nicht im Dokuemnt auftaucht

Global setup chunks



Präsentationen mit R Markdown



Präsentationen mit R Markdown mit dem Paket

xaringan

Wir wollen uns noch speziell mit Präsentationen mit R Markdown beschäftigen!



Präsentationen mit R Markdown mit dem Paket

xaringan

Wir wollen uns noch speziell mit Präsentationen mit R Markdown beschäftigen!

✚ Ihre Projektausarbeitung ist bereits in R Markdown

✚ Durch kleine Änderungen im YAML-Header können Sie daraus eine Präsentation erstellen mit Grafiken direkt aus R
mit hoher Qualität

✚ Pro Tip: Im Code Chunk dpi = 300 verwenden für gestochen scharfe Grafiken

#install.packages(xaringan)

library(xaringan)



Output-Format

---

output: xaringan::moon_reader

---



✚ Die erste Folie beginnt dort wo der YAML-Header
endet!

✚ Durch drei --- können Sie eine neue Folie beginnen

---

output: xaringan::moon_reader

---

Ich bin ihre 1. Folie

---

Und ich ihre zweite

Neue Folien



✚ Die erste Folie beginnt dort wo der YAML-Header
endet!

✚ Durch drei --- können Sie eine neue Folie beginnen

---

output: xaringan::moon_reader

---

Ich bin ihre 1. Folie

---

Und ich ihre zweite

Neue Folien



Sie können jede Folie individuell designen mit der
class: Option.

Möglichkeiten:

✚ Für die Position des Geschriebenen (vertikal): top,
bottom, middle

✚ Für die Position des Geschriebenen (horizontal): left,
right, center

✚ Um das Farbschema umzudrehen: inverse

---

output: xaringan::moon_reader

---

class: inverse, center, middle

# Introfolie

---

class: bottom, right

# Vorstellung

Ich bin ihre 1. Folie

---

Und ich ihre zweite

Neue Folien designen



Das Paket xaringanthemer

#install.packages("xaringanthemer")

library(xaringanthemer)

✚ Damit können Sie ihre Präsentationen auch ohne CSS oder remark.js Kenntnisse leicht anpassen und individualisieren

✚ Eine Einführung in xaringanthemer finden Sie hier

✚ Eine Einführung in xaringan finden Sie hier

https://pkg.garrickadenbuie.com/xaringanthemer/
https://slides.yihui.org/xaringan/#1


Ein beispielhafter YAML-Header
---

author: Alexander Rieber

date: '2024-10-04'

title: Beispielpräsentation in xaringan

output: 

  xaringan::moon_reader

    css: xaringan-themer.css

---

```{r xaringan-themer, include=FALSE, warning=FALSE}

library(xaringanthemer)

style_mono_accent(

  #Farbpalette richtet sich nach Hex-Farbcode (bspw. hier: https://encycolorpedia.de/)

  #Farbpalette kann leicht angepasst werden

  base_color = "#1c5253", 

  header_font_google = google_font("Josefin Sans"),

  text_font_google   = google_font("Montserrat", "300", "300i"),

  code_font_google   = google_font("Fira Mono")

)

```



Präsentationen

✚ Sie können sich auch gerne an den Folien zum Projektkurs orientieren z.B. mit dem Format 16:9 (ratio: "16:9")

✚ Natürlich müssen Sie ihre Ausarbeitung nicht in xaringan machen!

Jedoch bietet es sich an um die schönen Grafiken und Tabellen ohne Verlust in die Präsentation aufnehmen zu können.



R Projekte



Arbeiten mit R-Projekten

In R sollten Sie ihre Arbeit in Projekte strukturieren.

Ist sehr nützlich da in dem Fall alle nötigen Dateien beieinander in einem Projekt liegen, inkl. Historie etc.

✚ Mehr Informationen zu R-Projekten und warum diese sinnvoll sind finden Sie hier

Sie sollten für ihre unterschiedlichen Projekte immer einzelne R-Projekte erstellen

https://support.posit.co/hc/en-us/articles/200526207-Using-RStudio-Projects


Arbeiten mit R-Projekten

In R sollten Sie ihre Arbeit in Projekte strukturieren.

Ist sehr nützlich da in dem Fall alle nötigen Dateien beieinander in einem Projekt liegen, inkl. Historie etc.

✚ Mehr Informationen zu R-Projekten und warum diese sinnvoll sind finden Sie hier

Sie sollten für ihre unterschiedlichen Projekte immer einzelne R-Projekte erstellen

Projekt erzeugen bei vorhandenem Ordner:

File -> New Project -> Existing Directory -> Browse -> Open .Rmd

Projekt erzeugen bei neuem Ordner:

File -> New Project -> New Directory -> New Projekt -> Neuer Ordner erstellen

https://support.posit.co/hc/en-us/articles/200526207-Using-RStudio-Projects


Take aways
✚ Nutzen Sie YAML um Metadaten für ihr Dokument zu setzen

✚ Nutzen Sie YAML auch um ihr Dokument entsprechend aufzubauen (Inhaltsübersicht, Themes etc.)

✚ Verwenden Sie knitr Chunk Optionen (eval, echo, include ...) um ihr finales Dokument entsprechend zu gestalten

✚ Verwenden Sie fett, kursiv und Listenelemente um ihren Text zu strukturieren

✚ Verwenden Sie R Projekte für jedes neue Projekt das Sie starten



Take aways
✚ Nutzen Sie YAML um Metadaten für ihr Dokument zu setzen

✚ Nutzen Sie YAML auch um ihr Dokument entsprechend aufzubauen (Inhaltsübersicht, Themes etc.)

✚ Verwenden Sie knitr Chunk Optionen (eval, echo, include ...) um ihr finales Dokument entsprechend zu gestalten

✚ Verwenden Sie fett, kursiv und Listenelemente um ihren Text zu strukturieren

✚ Verwenden Sie R Projekte für jedes neue Projekt das Sie starten

knitten Sie früh und oft! Nur so können Sie sicher gehen das ihre Ergebnisse zu 100% reproduzierbar sind!



Quellen

✚ Eine sehr gute Einführung in RMarkdown und wie man damit wissenschaftliche Texte (z.B. auch Bachelorarbeiten)
schreibt finden Sie hier

✚ Eine allgemeine Einführung in RMarkdown von Alison Horst

✚ Alle Zeichnungen von Allison Horst und Desirée de Leon

https://resulumit.com/teaching/rmd_workshop.html
https://alison.rbind.io/tags/rmarkdown/
https://www.allisonhorst.com/
https://desiree.rbind.io/

